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Best Practices / Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and

conditions of this legal disclaimer before you read or use this document. If you have
read or used this document, it shall be deemed as your total acceptance of this legal
disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website
or other Alibaba Cloud-authorized channels, and use this document for your

own legal business activities only. The content of this document is considered
conﬁdential information of Alibaba Cloud. You shall strictly abide by the

conﬁdentiality obligations. No part of this document shall be disclosed or provided
to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted,

or disseminated by any organization, company, or individual in any form or by any
means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify

the content of this document without notice and the updated versions of this
document will be occasionally released through Alibaba Cloud-authorized

channels. You shall pay attention to the version changes of this document as they

occur and download and obtain the most up-to-date version of this document from
Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud

products and services. Alibaba Cloud provides the document in the context that
Alibaba Cloud products and services are provided on an "as is", "with all faults

" and "as available" basis. Alibaba Cloud makes every eﬀort to provide relevant
operational guidance based on existing technologies. However, Alibaba Cloud

hereby makes a clear statement that it in no way guarantees the accuracy, integrity
, applicability, and reliability of the content of this document, either explicitly

or implicitly. Alibaba Cloud shall not bear any liability for any errors or ﬁnancial
losses incurred by any organizations, companies, or individuals arising from

their download, use, or trust in this document. Alibaba Cloud shall not, under any
circumstances, bear responsibility for any indirect, consequential, exemplary,

incidental, special, or punitive damages, including lost proﬁts arising from the use
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or trust in this document, even if Alibaba Cloud has been notiﬁed of the possibility
of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to

works, products, images, archives, information, materials, website architecture,

website graphic layout, and webpage design, are intellectual property of Alibaba
Cloud and/or its aﬃliates. This intellectual property includes, but is not limited
to, trademark rights, patent rights, copyrights, and trade secrets. No part of the
Alibaba Cloud website, product programs, or content shall be used, modiﬁed

, reproduced, publicly transmitted, changed, disseminated, distributed, or

published without the prior written consent of Alibaba Cloud and/or its aﬃliates

. The names owned by Alibaba Cloud shall not be used, published, or reproduced

for marketing, advertising, promotion, or other purposes without the prior written
consent of Alibaba Cloud. The names owned by Alibaba Cloud include, but are

not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba

Cloud and/or its aﬃliates, which appear separately or in combination, as well as
the auxiliary signs and patterns of the preceding brands, or anything similar to

the company names, trade names, trademarks, product or service names, domain
names, patterns, logos, marks, signs, or special descriptions that third parties

identify as Alibaba Cloud and/or its aﬃliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions
Table -1: Style conventions
Style

Description

This warning information
indicates a situation that will

cause major system changes,
faults, physical injuries, and other
adverse results.
This warning information
indicates a situation that may

cause major system changes,
faults, physical injuries, and other
adverse results.
This indicates warning informatio
n, supplementary instructions,
and other content that the user
must understand.

This indicates supplemental
instructions, best practices, tips,
and other content that is good to
know for the user.

>

Multi-level menu cascade.

Bold

It is used for buttons, menus
, page names, and other UI
elements.

Courier It is used for commands.
font

Italics
[] or [a|b]

It is used for parameters and
variables.

It indicates that it is a optional
value, and only one item can be

Example
Danger:

Resetting will result in the loss of
user conﬁguration data.
Warning:

Restarting will cause business
interruption. About 10 minutes are
required to restore business.
Notice:

Take the necessary precautions
to save exported data containing
sensitive information.
Note:

You can use Ctrl + A to select all
ﬁles.

Settings > Network > Set network
type
Click OK.

Run the cd

/ d

C :/ windows

command to enter the Windows
system folder.
bae

log

list

--

instanceid Instance_ID
ipconfig [-all|-t]

selected.
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{} or {a|b} It indicates that it is a required
value, and only one item can be
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Example
swich {stand | slave}

selected.
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1 Use RAM to maintain security of your Alibaba
Cloud resources

This topic describes how to use RAM to apply access and security settings to your

Alibaba Cloud resources so that you can better manage access permissions with ﬁnegrained access control.

Scenario

When you migrate your business resources to the cloud, the traditional organizati

onal structures and previous management methods of your resources may no longer
meet your requirements. As a result, the migration of your resources may create

higher security management issues as follows:

• The responsibilities of the RAM users are not clear.

• The Alibaba Cloud account owner does not want to share the access key with RAM
users due to security risks involved.

• RAM users can access resources by using diﬀerent methods, which is not uniﬁed
and may mistakenly cause security risks.

• The resource access permissions of RAM users need to be frequently recalled when
the users no longer require these permissions.

Solution

To resolve the preceding issues, you can use RAM to create RAM users and grant

resource access permissions to RAM users. Speciﬁcally, you can use RAM to separate
the access key of your Alibaba Cloud account from RAM users and grant minimum

permissions to users as needed to maintain the security of your resources.
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Security management solution

• Create independent RAM users.

An enterprise needs only one Alibaba Cloud account. As a best practice, the

Alibaba Cloud account is not used for daily tasks. However, multiple RAM users

can be created under the account, and granted the necessary access permissions to
resources as needed.

For more information, see Create a RAM user.

2
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• Separate console users from API users.

We recommend that you do not create a logon password for console operations and
an access key for API operations for a RAM user at the same time.

- To allow an application to access cloud resources only through APIs, you only
need to create an access key for the application.

- To allow an employee to operate on cloud resources only through the console,
you only need to set a logon password for the employee.

For more information, see Create a RAM user.

• Create RAM users and group them.

If your Alibaba Cloud account has multiple RAM users, you can group RAM users
with same responsibilities and grant permissions to the group as needed.
For more information, see Create a RAM user group.

• Grant the minimum permissions to diﬀerent RAM user groups.

You can attach proper system policies to RAM users or user groups as needed.

You can also create custom policies for ﬁne-grained permission management. In
this way, by granting the minimum permissions to diﬀerent RAM users and user

groups, you can better manage the RAM users' operations on the cloud resources.
For more information, see Create a custom policy.

• Conﬁgure strong password policies.

You can conﬁgure password policies with custom conventions regarding the

minimum length, mandatory characters, and validation period, for RAM users in

the RAM console. If a RAM user is allowed to change their logon password, the user
must create a strong logon password and rotate the password or access key on a

regular basis.

For more information, see Set a security policy for RAM users.
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• Enable an MFA device for your Alibaba Cloud account.

You can enable a multi-factor authentication (MFA) device for your Alibaba Cloud
account to enhance the account security. When you log on to Alibaba Cloud with
MFA enabled, the system requires the following two security factors:
1. Your username and password

2. Veriﬁcation code provided by the MFA device

For more information, see Enable an MFA device for an Alibaba Cloud account.

• Enable SSO for RAM users.

After Single Sign On (SSO) is enabled, all the internal accounts of your enterprise
will be authenticated. Then, users can log on to Alibaba Cloud to access

corresponding resources only by using an internal account.
For more information, see Overview of user-based SSO.

• Do not share the access key of your Alibaba Cloud account.

Your Alibaba Cloud account has full control permissions over resources under

it, and its access keys have the same permissions as logon passwords. However,

access keys are used for programmatic access whereas logon passwords are used
to log on to the console. Therefore, to avoid information leaks due to misuse of

an access key, we recommend that you do not share or use the access key of your
Alibaba Cloud account.

Instead, create a RAM user and grant this user the relevant permissions.
For more information, see Create an access key for a RAM user.

• Specify operation conditions to enhance security.

You can specify the operational conditions that a RAM user must meet before they
can use your cloud resources. For example, you can specify that the RAM user
must use a secure channel (such as SSL), use a speciﬁed source IP address, or

operate within a speciﬁed period of time.

For more information, see Policy elements.
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• Manage permissions of your cloud resources.

By default, all your resources are under your Alibaba Cloud account. A RAM user
can use the resources but do not own the resources. This allows you to easily
manage the instances or data created by RAM users.

- For an existing RAM user that you no long require, you can remove all of its
corresponding permissions by simply removing the RAM user account.

- For a RAM user that requires a permission, you need to ﬁrst create the RAM user
, set the logon password or access key for it, and then grant the RAM user the
relevant permissions as needed.

For more information, see Grant permission to a RAM user.

• Use STS to grant temporary permissions to RAM users.

The Security Token Service (STS) is an extended authorization service of RAM.
You can use STS to grant temporary permissions to RAM users and specify the
permission and automatic expiration time of the tokens as needed.
For more information, see What is STS?
Note:

You must register an Alibaba Cloud account before you use RAM to maintain security
of your Alibaba Cloud resources.

Result

After migrating your services to the cloud, you can use the preceding solutions to

ensure you manage your cloud-based resources eﬀectively and keep your Alibaba
Cloud account and all business assets secure.

What to do next

You can use RAM to categorize your O&M requirements and assign tasks to diﬀerent
engineers as needed. For more information, see Manage permissions of diﬀerent
O&M engineers by using RAM.
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2 Manage permissions of diﬀerent O&M engineers
by using RAM

You can grant and manage the permissions of diﬀerent O&M engineers by using RAM
to meet various O&M requirements while also facilitating better management and
control.

Scenario

Your company purchases several Alibaba Cloud products and deploys a number of
application systems on the cloud, which brings greater O&M requirements.

• Diﬀerent O&M owners are responsible for diﬀerent Alibaba Cloud products.

• Diﬀerent O&M engineers require diﬀerent permissions to access, operate, and
manage cloud resources.

Solution

You can categorize the O&M requirements by product to make them easier to manage.
More speciﬁcally, you can set an O&M owner and assign diﬀerent O&M engineers

to diﬀerent categories of requirements and attach your speciﬁed policies to these
engineers, as shown in the following ﬁgure.
Figure 2-1: O&M owner
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O&M owner
O&M owner
VM O&M
engineer

Best Practices / 2 Manage permissions of diﬀerent O&M
engineers by using RAM

Policy

AdministratorAccess
AliyunECSFullAccess

AliyunESSFullAccess

AliyunSLBFullAccess

AliyunNASFullAccess

AliyunOSSFullAccess

AliyunOTSFullAccess
Network O&M
engineer

AliyunCDNFullAccess

AliyunCENFullAccess

Description

This policy grants the O&M
owner the permission to manage
all Alibaba Cloud resources.

This policy grants the VM O&
M engineer the permission to

manage Elastic Compute Service
(ECS).
This policy grants the VM O&
M engineer the permission to

manage Elastic Scaling Service (
ESS).
This policy grants the VM O&
M engineer the permission to

manage Server Load Balancer (
SLB).
This policy grants the VM O
&M engineer the permission

to manage Network Attached
Storage (NAS).

This policy grants the VM O&
M engineer the permission to

manage Object Storage Service (
OSS).
This policy grants the VM O&
M engineer the permission to
manage Table Store (OTS).

This policy grants the network
O&M engineer the permission
to manage Content Delivery
Network (CDN).

This policy grants the network
O&M engineer the permission
to manage Cloud Enterprise
Network (CEN).
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AliyunCommonBandwidt
hPackageFullAccess
AliyunEIPFullAccess
AliyunExpressConnect
FullAccess
AliyunNATGatewayFullAccess
AliyunSCDNFullAccess

AliyunSmartAccessGat
ewayFullAccess
AliyunVPCFullAccess

AliyunVPNGatewayFullAccess
Database O&M
engineer

AliyunRDSFullAccess

AliyunDTSFullAccess

Security O&M
engineer
8

AliyunYundunFullAccess

Description

This policy grants the network
O&M engineer the permission
to manage Internet Shared
Bandwidth.

This policy grants the network O
&M engineer the permission to
manage Elastic IP (EIP).

This policy grants the network O
&M engineer the permission to
manage ExpressConnect.

This policy grants the network O
&M engineer the permission to
manage NAT Gateway.

This policy grants the network O
&M engineer the permission to
manage Secure Content Delivery
Network (SCDN).

This policy grants the network O
&M engineer the permission to
manage Smart Access Gateway.

This policy grants the network O
&M engineer the permission to
manage Virtual Private Cloud (
VPC).

This policy grants the network O
&M engineer the permission to
manage VPN Gateway.

This policy grants the database
O&M engineer the permission
to manage Relational Database
Service (RDS).

This policy grants the database
O&M engineer the permission
to manage Data Transmission
Service (DTS).

This policy grants the security O
&M engineer the permission to
manage Alibaba Cloud Security.
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AliyunActionTrailFullAccess

AliyunARMSFullAccess

AliyunCloudMonitorFullAccess

(Optional) ReadOnlyAccess

AliyunSupportFullAccess

Description

This policy grants the
monitoring O&M engineer
the permission to manage
ActionTrail.

This policy grants the
monitoring O&M engineer the

permission to manage Applicatio
n Real-Time Monitoring Service
ARMS).
This policy grants the
monitoring O&M engineer
the permission to manage
CloudMonitor.

(Optional) This policy grants
the monitoring O&M engineer

the read-only permission to all
Alibaba Cloud resources.
This policy grants the
monitoring O&M engineer the

permission to manage Alibaba
Cloud support systems.
Example

This example describes how to set the RAM user alice @ secloud . onaliyun .
com as the database O&M owner, so that the user can manage RDS and DTS.

1. Log on to the RAM console.

2. Create a RAM user and name the user alice @ secloud . onaliyun . com .
3. Find the created RAM user and click Add Permissions.
4. In the Policy Name column, select AliyunRDSF
ullAccess , and click Ok.

ullAccess and AliyunDTSF

Note:

To grant other O&M permissions to the RAM user, see the policies described in the
preceding table.
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3 User management and access control

This topic provides an example scenario that describes how to use Alibaba Cloud
RAM to manage user permissions and resources.

Scenario

Assume that Enterprise A has bought several types of Alibaba Cloud resources, such

as ECS instances, RDS instances, SLB instances, and OSS buckets, for Project-X. In this
project, multiple employees need to perform operations on these cloud resources.

Speciﬁcally, diﬀerent employees require diﬀerent permissions to complete diﬀerent
operations.

Requirement analysis

• Employees do not share the Alibaba Cloud account to avoid mistaken disclosure of
the account password or AccessKey.

• Independent RAM users are created for diﬀerent employees and the RAM users are
granted independent permissions.

• All operations of all RAM users can be audited.

• Fees are not charged to each RAM user, but are instead charged to the correspond
ing Alibaba Cloud account to which the RAM users belong.

Solution

Figure 3-1: Solution

10
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1. Set multi-factor authentication (MFA) to avoid risks associated with mistaken

disclosure of the Alibaba Cloud account password. For more information, see
(Optional) Set MFA.

2. Create RAM users for diﬀerent employees (or applications) and set logon

passwords or create AccessKeys. For more information, see Create a RAM user.

3. If multiple RAM users require the same permissions, we recommend that you

create a user group and add the corresponding users to this user group. For more
information, see (Optional) Create a RAM user group.

4. Attach one or more system policies to the groups or users. For more information,

see #unique_21. For ﬁner-grained permission management, you can create one or
more custom policies and attach them to individual users or to a user group. For

more information, see #unique_22/unique_22_Connect_42_section_qpw_vwf_xdb.

Issue: 20190815

11

Resource Access Management

Best Practices / 4 Grant temporary permissions to
mobile apps

4 Grant temporary permissions to mobile apps
This topic describes how to use the RAM role STS token to grant temporary
permissions to mobile apps.

Scenario

Enterprise A has developed a mobile app, which runs on users' own devices.

Therefore, Enterprise A cannot manage these devices directly and wants to use

Alibaba Cloud OSS so that the mobile app can upload data to and download data from
OSS.

The requirements of Enterprise A are as follows:

• Enterprise A does not want the app to use the appServer to transmit data. Instead,
it wants the app to directly upload data to and download data from OSS.

• To maintain account security, Enterprise A will not save the AccessKey to

the mobile app because mobile devices that run the app are not managed by
Enterprise A directly.

• Enterprise A wants to minimize its security risks by granting the app temporary

access credentials (by means of an STS token) that the app can then use to connect
to OSS, thereby restricting the access duration to a speciﬁed period of time.

Solution

• Use the Alibaba Cloud account of Enterprise A (Account A) to create a role in RAM,

grant relevant permissions to the role, and allow the appServer (which is logged on
as a RAM user) to use this role.

For more information, see Create a RAM role and user, and grant permissions.

• When an app needs to connect directly to OSS to upload or download data,

the appServer can assume a role (by calling the STS AssumeRole API) to get
a temporary STS token and transfer it to the app. Then, the app can use the
temporary STS token to access the OSS API directly.

For more information, see Obtain and transfer the role STS token and access OSS.

12
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• The appServer can further limit the resource operation permissions of the

temporary STS token when it assumes the role, to better manage the permissions
of each app.

For more information, see Restrict STS token permissions.

Create a RAM role and user, and grant permissions

Assume that the account ID of Account A is 11223344.

1. Account A creates a RAM role oss - readonly and selects Current Alibaba

Cloud Account as the trusted account so that only RAM users under Account A can
assume this role.

For more information, see #unique_27.

After creating the role, Enterprise A can view the role information on the basic
information page.

• In this example, the Alibaba Cloud Resource Name (ARN) of the role is as
follows:

acs : ram :: 11223344 : role / oss - readonly
• The trust policy in the role (in which only RAM users under Account A can
assume) is as follows:

{
" Statement ": [
{
" Action ": " sts : AssumeRole ",
" Effect ": " Allow ",
" Principal ": {
" RAM ": [
" acs : ram :: 11223344 : root "// If
the
trusted
entity
type
of
the
role
is
Alibaba
Cloud
account
, ' root ' is
used
by
default .
]
}
}
],
" Version ": " 1 "
}
2. Account A attaches the policy AliyunOSSR
permission) to the role oss-readonly.

eadOnlyAcc

ess (OSS read-only

For more information, see #unique_21.

3. Account A creates a RAM user (here, the RAM user is named Appserver) for the

appServer, creates an AccessKey for the RAM user, and attaches the AliyunSTSA
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ccess system policy to the user so that the user can call the STS

AssumeRole API.

Obtain and transfer the role STS token and access OSS

The procedure for an app to obtain a role STS token and use it to call the OSS API is
illustrated in the following ﬁgure.
Figure 4-1: Procedure

The appServer uses the AccessKey of the RAM user Appserver to call the STS API
AssumeRole.
Note:

The AccessKey for the appServer must be conﬁgured.

The following is an example of how to use aliyuncli to call the AssumeRole API:
$ aliyuncli
sts
AssumeRole -- RoleArn
acs : ram :: 11223344 :
role / oss - readonly -- RoleSessio nName
client - 001
{
" AssumedRol eUser ": {
" AssumedRol eId ": " 3915787525 73972854 : client - 001
",
" Arn ": " acs : ram :: 11223344 : role / oss - readonly /
client - 001 "
},
" Credential s ": {
14
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" AccessKeyS ecret ": " 93ci2umK1Q KNEja6WGqi 1Ba7Q2Fv9P
wxZqtVF2Vy nUvz ",
" SecurityTo ken ": " CAES6AIIAR KAAUiwSHpk D3GXRMQk9s
tDr3YSVbyG qanqkS + fPlEEkjZ + dlgFnGdCI2 PV93jksole 8ijH8dHJrH
RA5JA1YCGs fX5hrzcNM3 7Vr4eVdWFV QhoCw0DXBp Hv // ZcITp +
ELRr4MHsny GiErnDsXLk I7q / sbuWg6PACZ / jzQfEWQb / f7Y1Gh1TVF
MuRjEzR2pz a1hUamszOG RCWTZZeEp0 WEFaayISMz kxNTc4NzUy
NTczOTcyOD U0KgpjbGll bnQtMDAxMK T + lIHBKjoGUn NhTUQ1QkoK
ATEaRQoFQW xsb3cSGwoM QWN0aW9uRX F1YWxzEgZB Y3Rpb24aAw
oBKhIfCg5S ZXNvdXJjZU VxdWFscxII UmVzb3VyY2 UaAwoBKkoF
NDMyNzRSBT I2ODQyWg9B c3N1bWVkUm 9sZVVzZXJg AGoSMzkxNT
c4NzUyNTcz OTcyODU0cg llY3MtYWRt aW544Mbewo / 26AE =",
" Expiration ": " 2016 - 01 - 13T15 : 02 : 37Z ",
" AccessKeyI d ": " STS . F13GjskXTj k38dBY6YxJ tXAZk "
},
" RequestId ": " E1779AAB - E7AF - 47D6 - A9A4 - 53128708B6 CE "
}
Restrict STS token permissions

1. After calling the AssumeRole API, you can grant ﬁne-grained permissions to the
STS token.

Speciﬁcally, if you do not specify a policy when calling the AssumeRole API, the

STS token has all permissions of oss - readonly . To solve this issue, you can

specify a policy to further restrict the permissions of the STS token, for example,

only allow the STS token to access sample - bucket / 2015 / 01 / 01 /*. jpg
. The following is an example:

$ aliyuncli
sts
AssumeRole -- RoleArn
acs : ram :: 11223344
: role / oss - readonly -- RoleSessio nName
client - 002 -Policy "{\" Version \":\" 1 \", \" Statement \": [{\" Effect \":\"
Allow \", \" Action \":\" oss : GetObject \", \" Resource \":\" acs
: oss :*:*: sample - bucket / 2015 / 01 / 01 /*. jpg \"}]}"
{
" AssumedRol eUser ": {
" AssumedRol eId ": " 3915787525 73972854 : client - 002
",
" Arn ": " acs : ram :: 11223344 : role / oss - readonly /
client - 002 "
},
" Credential s ": {
" AccessKeyS ecret ": " 28Co5Vyx2X htTqj3RJgd ud4ntyzrSN
dUvNygAj7x EMow ",
" SecurityTo ken ": " CAESnQMIAR KAASJgnzMz lXVyJn4KI
+ FsysaIpTGm 8ns8Y74HVE j0pOevO8ZW Xrnnkz4a4r BEPBAdFkh3
197GUspruj siU78Fkszx hnQPKkQKcy vPihoXqKvu ukrQ / Uoudk31KAJ
Ez5o2EjlNU REcxWjRDRS ISMzkxNTc4 NzUyNTczOT cyODU0Kgpj
bGllbnQtMD AxMKmZxIHB KjoGUnNhTU Q1Qn8KATEa egoFQWxsb3
cSJwoMQWN0 aW9uRXF1YW xzEgZBY3Rp b24aDwoNb3 NzOkdldE9i
amVjdBJICg 5SZXNvdXJj ZUVxdWFscx IIUmVzb3Vy Y2UaLAoqYW
NzOm9zczoq Oio6c2FtcG xlLWJ1Y2tl dC8yMDE1Lz AxLzAxLyou
anBnSgU0Mz I3NFIFMjY4 NDJaD0Fzc3 VtZWRSb2xl VXNlcmAAah
IzOTE1Nzg3 NTI1NzM5Nz I4NTRyCWVj cy1hZG1pbn jgxt7Cj / boAQ
==",
" Expiration ": " 2016 - 01 - 13T15 : 03 : 39Z ",
" AccessKeyI d ": " STS . FJ6EMcS1JL ZgAcBJSTDG 1Z4CE "
},
Issue: 20190815
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" RequestId ": " 98835D9B - 86E5 - 4BB5 - A6DF - 9D3156ABA5

67 "

Note:

The default validity period of the STS token is 3600 seconds (maximum limit). You
can use the DurationSeconds parameter to limit the STS token expiration time.

2. The appServer obtains and parses the credentials.

• The appServer obtains the AccessKeyId, AccessKeySecret, and STS token from
the credentials returned by the AssumeRole API.

• The STS token validity period is determined. If the application requires a longer

validity period, the appServer must re-issue a new STS token, for example, issue
one STS token every 1800 seconds.

3. The appServer securely transfers the STS token to the app.

4. The app uses the STS token to directly access APIs of Alibaba Cloud services (such
as OSS).

The following is an example of how to use aliyuncli and an STS token to access an
OSS object (here, the STS token is issued to client-002):

Configure
the
STS
token
syntax : aliyuncli
oss
Config
-- host
-- accessid
-- accesskey
-- sts_token
$ aliyuncli
oss
Config -- host
oss . aliyuncs . com -accessid
STS . FJ6EMcS1JL ZgAcBJSTDG 1Z4CE -- accesskey
28Co5Vyx2X htTqj3RJgd ud4ntyzrSN dUvNygAj7x EMow -- sts_token
CAESnQMIAR KAASJgnzMz lXVyJn4KI + FsysaIpTGm 8ns8Y74HVE
j0pOevO8ZW Xrnnkz4a4r BEPBAdFkh3 197GUspruj siU78Fkszx
hnQPKkQKcy vPihoXqKvu ukrQ / Uoudk31KAJ Ez5o2EjlNU REcxWjRDRS
ISMzkxNTc4 NzUyNTczOT cyODU0Kgpj bGllbnQtMD AxMKmZxIHB
KjoGUnNhTU Q1Qn8KATEa egoFQWxsb3 cSJwoMQWN0 aW9uRXF1YW
xzEgZBY3Rp b24aDwoNb3 NzOkdldE9i amVjdBJICg 5SZXNvdXJj
ZUVxdWFscx IIUmVzb3Vy Y2UaLAoqYW NzOm9zczoq Oio6c2FtcG
xlLWJ1Y2tl dC8yMDE1Lz AxLzAxLyou anBnSgU0Mz I3NFIFMjY4
NDJaD0Fzc3 VtZWRSb2xl VXNlcmAAah IzOTE1Nzg3 NTI1NzM5Nz
I4NTRyCWVj cy1hZG1pbn jgxt7Cj / boAQ ==
access
OSS
objects
$ aliyuncli
oss
Get
oss :// sample - bucket / 2015 / 01 / 01
/ grass . jpg
grass . jpg
What to do next

For more information, see:

• Set up direct data transfer for mobile apps
• Permission control

• Set up data callback for mobile apps
16
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5 Cross-account resource authorization and access
This topic describes how to use RAM roles to perform cross-account resource
authorization and access.

Scenario

Account A and Account B represent two diﬀerent enterprises (Enterprise A and

Enterprise B, respectively). Enterprise A has bought various cloud resources (such as

ECS instances, RDS instances, SLB instances, and OSS buckets) to support its business
.

Requirement analysis

• Account A is the resource owner and wants to grant Account B the relevant
permissions to perform operations on resources of Account A.

• Account B wants to further grant the permissions to its RAM users (employees or

applications). If an employee of Account B joins or leaves Enterprise B, Account A
cannot make any changes to the permissions.

• If Enterprise A or Enterprise B ends the agreement, Account A can remove the
permissions of Account B at any time.

Solution

Use RAM roles to perform cross-account authorization and resource access.

• Account A creates a role in RAM, grants relevant permissions to the RAM role, and
allows Account B to use this role.

For more information, see Cross-account authorization.

• If an employee (that is, a RAM user) under Account B needs to use this role,

Account B can grant permissions to this RAM user to perform operations on the
resources of Account A.

For more information, see Cross-account resource access.

• If Enterprise A or Enterprise B ends the agreement, Account A can revoke the
permissions of Account B. In this case, all RAM users of Account B lose the
permissions associated with this role.

For more information, see Removing cross-account authorization.
18
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The following ﬁgure shows how to use a RAM role to achieve cross-account

authorization. In this example, Enterprise A (whose account ID is 11223344 and
account alias is company-a) needs to grant ECS operation permissions to the

employees of Enterprise B (whose account ID is 12345678 and account alias is
company-b).

Figure 5-1: Use a RAM role to achieve cross-account authorization

1. Account A creates a RAM role (here, the role is named ecs-admin) and selects Other
Alibaba Cloud Account (here, the account ID is 12345678) as a trusted entity.
For more information, see #unique_27.

After creating the role, Account A can view the role information on the Basic
Information page.

• In this example, the Alibaba Cloud Resource Name (ARN) of the role is as
follows:

acs : ram :: 11223344 : role / ecs - admin
• The trust policy in the role (in which only RAM users under Account B can
assume) is as follows:
{
" Statement ": [
{
Issue: 20190815
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" Action ": " sts : AssumeRole ",
" Effect ": " Allow ",
" Principal ": {
" RAM ": [
" acs : ram :: 12345678 : root "
]
}

}
],
" Version ": " 1 "
}

2. Account A attaches the AliyunECSF

ullAccess policy to the role ecs-admin.

For more information, see #unique_21.

3. Account B creates a RAM user (here, the RAM user is named Alice) for its

employee, sets a logon password for the RAM user, and attaches the AliyunSTSA
ssumeRoleA

API.

ccess system policy for the RAM user to call the STS AssumeRole

Cross-account resource access

To allow RAM user Alice under Account B to access the ECS resources of Account A (
through the Alibaba Cloud console), follow these steps:
1. Log on to the RAM console.

During logon, enter the account alias company-b, RAM user name Alice, and
password 123456.

2. Move the pointer over the account icon and click Switch Role.

On the displayed page, enter company-a for Enterprise Alias/Default Domain Name
and ecs-admin for Role Name.
Note:

After completing the preceding operations, the RAM user Alice can perform
operations on the ECS resources of Account A.

Removing cross-account authorization

If Account A wants to remove the permission of using the role ecs-admin from
Account B, the procedure is as follows:

1. Log on to the RAM console, click RAM Roles, and click the role name of ecs-admin.

20
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2. Click the Trust Policy Management tab and delete acs : ram :: 12345678 :
root .

Note:

Account A can also remove the permission of using the role ecs-admin from

Account B by deleting the ecs-admin role on the RAM Roles page. However, the
role cannot have any policies attached to it before being deleted.

Issue: 20190815

21

Resource Access Management

Best Practices / 6 Use RAM to authorize applications to
access Alibaba Cloud resources

6 Use RAM to authorize applications to access
Alibaba Cloud resources

This topic describes how to use RAM to authorize applications to access Alibaba
Cloud resources by obtaining the temporary STS token of a RAM role.

Scenario

An enterprise has bought ECS instances and wants to deploy its applications in ECS.

To allow the applications to access other Alibaba Cloud APIs by using access keys, the
enterprise can use one of the following methods:
• Embed the access keys into the code.

• Save the access keys in the conﬁguration ﬁles of the applications.

However, if the preceding methods are used, the following issues occur:

• Access key disclosure: If the access keys are embedded in the ECS instances in

plaintext, they can be mistakenly disclosed to another user due to the sharing of a
snapshot, or an image to create a shared image instance.

• O&M complexity: If the access keys are changed (due to access key rotation or
changes to user identities), all instances and images need to be updated and

redeployed because the access keys exist in the ECS instances. As a result, the
management of instances and images is highly complex.

Solution

To resolve the preceding issues, the enterprise can combine ECS with the access

control feature of RAM. Speciﬁcally, the administrator creates a RAM role for each

ECS instance (that is, the operating environment of the applications) and grants each

RAM role appropriate permissions. The applications can use the temporary STS token
of the corresponding RAM role to call other Alibaba Cloud APIs.

22
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1. The enterprise uses its Alibaba Cloud account to create a RAM role ( MyApplicat
ionRole ).

Note:

The preceding role is an Alibaba Cloud service in which ECS is selected as the
trusted service.

For information about how to create a RAM role, see Create a RAM role for a
trusted Alibaba Cloud service.

2. The enterprise uses its Alibaba Cloud account to grant relevant permissions to the
RAM role.

For information about how to grant permission to a RAM role, see Grant
permission to a RAM role.
Note:

If the temporary STS token does not have corresponding permissions, the

enterprise needs to attach related policies to the RAM role. After the policies
Issue: 20190815
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attached to the RAM role are updated, the permissions associated with the

temporary STS token take eﬀect immediately and the user does not need to restart
the ECS instance.

3. The enterprise uses its Alibaba Cloud account to create a RAM user.

For information about how to create a RAM user, see Create a RAM user.

4. The enterprise uses its Alibaba Cloud account to grant relevant permissions to the
RAM user.

• If the administrator and the RAM user have the same responsibilities, the
Administra

torAccess permission should be granted to the user.

• If the administrator and the RAM user have diﬀerent responsibilities, the
PassRole permission should be granted to the user.

The enterprise uses its Alibaba Cloud account to create a custom policy in the
RAM console and attach the policy to the RAM user. The policy content is as
follows:
{

}

" Statement ": [
{
" Effect ": " Allow ",
" Action ": " ram : PassRole ",
" Resource ": " acs : ram :*:*: role / MyApplicat
"// Replace
MyApplicat ionRole
with
the
name
RAM
role .
}
],
" Version ": " 1 "

ionRole
of
your

Note:

- Only authorized RAM users can conﬁgure RAM roles for ECS instances. In

this way, the use of RAM roles is strictly controlled, which helps to prevent
any abuse of permission usage.

- Before a RAM user (for example, a RAM user that only has access to ECS

and is not a RAM permission administrator) creates an ECS instance and

conﬁgures a RAM role, ECS checks whether the RAM user has the ram :
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permission of the RAM role. If no permission is found, the RAM

user cannot create an ECS instance.

For information about how to create a custom policy, see Create a custom policy.
For information about how to grant permission to a RAM user, see Grant
permission to a RAM user.

5. The RAM user starts the ECS instance and then conﬁgures the RAM role.

6. ECS calls the AssumeRole action of the STS API to obtain the temporary STS token
of the RAM role.
Note:

STS veriﬁes the identity of ECS and the policies attached to the RAM role. If the

veriﬁcation succeeds, a temporary STS token is issued. If the veriﬁcation fails, the
request is denied.

For information about how to use a RAM role by calling an STS API action, see Use
the instance RAM role by calling APIs.

7. STS returns the temporary STS token to ECS.

8. ECS sends the temporary STS token to applications in the ECS instance by using the
instance metadata.

• In Linux, the temporary STS token and its validity period can be obtained by

using the instance metadata. For more information, see Access other Alibaba
Cloud APIs by using instance RAM roles.
Request example:
$

curl
http :// 100 . 100 . 100 . 200 / latest / meta - data /
ram / security - credential s / MyApplicat ionRole

Response example
[ root @ local ~]# curl
http :// 100 . 100 . 100 . 200
/ latest / meta - data / ram / security - credential s /
MyApplicat ionRole
{
" AccessKeyI d " : " STS . J8XXXXXXXX XX4 ",
" AccessKeyS ecret " : " 9PjfXXXXXX XXXBf2XAW ",
" Expiration " : " 2017 - 06 - 09T09 : 17 : 19Z ",
" SecurityTo ken " : " CAIXXXXXXX XXXXwmBkle CTkyI +",
" LastUpdate d " : " 2017 - 06 - 09T03 : 17 : 18Z ",
" Code " : " Success "
} cess "
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• If the applications use an Alibaba Cloud SDK, the Alibaba Cloud SDK can obtain
the STS token of the RAM role from the ECS instance metadata, and you do not
need to conﬁgure any access key-related information in the SDK.

For more information, see Conﬁgure a RAM role to access ECS instances without
using an access key.
Note:

The applications can access Alibaba Cloud APIs when the temporary STS token
is within the validity period. The STS token usually expires after one hour. ECS
automatically refreshes the STS token before it expires.

9. The applications use the STS token to access Alibaba Cloud APIs.

What to do next

If Alibaba Cloud RAM does not meet all of your permission application requiremen
ts, you can use other Alibaba Cloud services, such as Function Compute and

MaxCompute, that provide the access control features to authorize applications to
access your Alibaba Cloud resources.
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7 Use tags to authorize ECS instances by group

This topic describes how to use tags to authorize resources (such as ECS instances) by
group so that RAM users can only view and operate on the tagged resources.

Scenario

You have 10 ECS instances. You want your dev team to manage 5 of them, and your
ops team to manage the other 5. However, you want each team to see only their

authorized resources (not the authorized resources of the other team).

Preparations

Make sure that you can log on to the RAM console by using your RAM account.

Solution

Create two RAM user groups, tag these two groups, and grant permissions to the
groups.

• Tag ﬁve of them with the key as team and the value as dev.

• Tag the other ﬁve with the key as team and the value as ops.

Procedure

1. Log on to the ECS console, click Instances, and select the target instance. In the
Actions column, choose More > Instance Settings > Edit Tag.

2. Click Create, enter the key and value, and click Conﬁrm.

3. Log on to the RAM console, create two RAM user groups, and name the groups as
dev and ops.

For more information, see (Optional) Create a RAM user group.

4. Create RAM users and add the users to diﬀerent user groups.
For more information, see Create a RAM user.

5. Create two custom policies and attach them to diﬀerent user groups.
For more information, see Permission granting in RAM.
Note:
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After you attach a policy to a user group, the RAM users in this group inherit the
relevant permissions.

In this example, the policy name of the dev user group is policyForDevTeam. The
policy content is as follows:
{

}

" Statement ": [
{
" Action ": " ecs :*",
" Effect ": " Allow ",
" Resource ": "*",
" Condition ": {
" StringEqua ls ": {
" ecs : tag / team ": " dev "
}
}
},
{
" Action ": " ecs : DescribeTa g *",
" Effect ": " Allow ",
" Resource ": "*"
}
],
" Version ": " 1 "

In the preceding policy,

• The " Action ": " ecs :*" element with "Condition" is used to ﬁlter the
instances tagged as " team ": " dev ".

• The " Action ": " ecs : DescribeTa

g *" element is used to display all

tags. When a user performs operations in the ECS console, the system displays

all the tags for the user to select, and then ﬁlters the instances according to the
tag key and value selected by the user.
Note:

You can create the policy policyForOpsTeam according to the example and grant
this policy to the ops user group.

Display authorized instances

1. Log on to the ECS console as a RAM user.
Note:

After a user logs on to the ECS console, the system navigates to the ECS overview
page by default. In this case, the number of the ECS instances displayed on the
28
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2. Click Instances and click Tags next to the search box.
Note:

You need make sure that the region displayed in the console is the region to which
the instances belong.

3. Move the pointer over Tag Key. The Tag Value list is displayed. Select a value, and
the system then ﬁlters the corresponding instances.

What to do next

You can use the procedures described in this topic to tag and authorize security
groups, disks, snapshots, and images by group.
Note:

Only custom images can be tagged.
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8 Use tags to authorize RDS instances by group

This topic describes how to use tags to authorize resources (such as RDS instances) by
group so that RAM users can only view and operate on the tagged resources.

Scenario

You have 10 RDS instances. You want your dev team to manage 5 of them, and your
ops team to manage the other 5. However, you want each team to see only their

authorized instances (not the authorized resources of the other team).

Preparations

For more information, see Use tags to authorize ECS instances by group.
The following is an example of the custom policy relevant to RDS:
{

}

" Statement ": [
{
" Action ": " rds :*",
" Effect ": " Allow ",
" Resource ": "*",
" Condition ": {
" StringEqua ls ": {
" rds : ResourceTa g / team ": " dev "
}
}
},
{
" Action ": " rds : DescribeTa g *",
" Effect ": " Allow ",
" Resource ": "*"
}
],
" Version ": " 1 "

In the preceding policy,

• The " Action ": " rds :*" element with "Condition" is used to ﬁlter the

instances tagged as " team ": " dev ". The keyword of "Condition" is rds :
ResourceTa

g .

• The " Action ": " rds : DescribeTa

g *" element is used to display all tags.

When a user performs operations in the RDS console, the system displays all the
tags for the user to select, and then ﬁlters the instances according to the tag key
and value selected by the user.
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If the relevant permissions of a RAM user are missing after you have tagged RDS
instances into groups and granted permissions, see #unique_47.
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9 Manage ECS permissions by using RAM

This topic describes how to manage ECS permissions of RAM users by creating
policies in RAM.

Common policies

The following table lists some common policies that can be created in RAM to
manage ECS permissions.
Policy

Description

AliyunECSReadOnlyAccess

Grants a RAM user read-only permission
for ECS instances.

AliyunECSFullAccess

Grants a RAM user full management
permissions for ECS instances.

Note:

For more information about ECS permissions, see Authentication rules.

Attach custom policies to RAM users

1. Create custom policies according to the subsequent ECS authorization examples.
For more information, see #unique_50.

2. Locate the target policy and click the policy name.
3. On the References tab, click Grant Permission.

4. In the Principal ﬁeld, enter the ID or name of the target RAM user.
5. Click OK.

Note:

You can also attach policies to a RAM user or a RAM user group as needed. For
more information, see Permission granting in RAM.

ECS authorization examples

• Example 1: As a RAM administrator with multiple instances, authorize a user to
operate on only two of your instances.

The IDs of these two ECS instances are i-001 and i-002.
{
32
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" Statement ": [
{
" Action ": " ecs :*",
" Effect ": " Allow ",
" Resource ": [
" acs : ecs :*:*: instance / i - 001 ",
" acs : ecs :*:*: instance / i - 002 "
]
},
{
" Action ": " ecs : Describe *",
" Effect ": " Allow ",
" Resource ": "*"
}
],
" Version ": " 1 "

Note:

- The authorized RAM user can view all the ECS instances but can only operate
on two of them.

- The Describe * element is required in a policy. If a policy does not contain

the Describe * element, the authorized RAM user cannot view any instance
in the console. However, the RAM user can operate on the two speciﬁed ECS
instances by calling API actions, by using the CLI, or by using ECS SDKs.

• Example 2: As a RAM administrator, authorize a RAM user to view ECS instances

in the Qingdao region, but do not allow them to view information about disks and
snapshots.

You can grant ECS permissions to the user by region and resource type.
{

}

" Statement ": [
{
" Effect ": " Allow ",
" Action ": " ecs : Describe *",
" Resource ": " acs : ecs : cn - qingdao :*: instance /*"
}
],
" Version ": " 1 "

• Example 3: As a RAM administrator, authorize a RAM user to create snapshots.

If a RAM user cannot create disk snapshots after being granted the ECS instance

administrator permission, you must grant disk permissions to the user again. In
this example, the ECS instance ID is inst-01 and the disk ID is dist-01.
{

" Statement ": [
{
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ecs :*",
Allow ",
[
:*:*: instance / inst - 01 "

" Action ": "
" Effect ": "
" Resource ":
" acs : ecs
" acs : ecs
]

ecs :
Allow
[
:*:*:
:*:*:

},
{

" Action ": "
" Effect ": "
" Resource ":
" acs : ecs
]

CreateSnap
",

shot ",

disk / dist - 01 ",
snapshot /*"

},
{

" Action ": [
" ecs : Describe *"
],
" Effect ": " Allow ",
" Resource ": "*"

}

34
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10 Manage OSS permissions by using RAM

This topic describes how to manage OSS permissions of RAM users by creating
policies in RAM.

Common policies

The following table lists some common policies that can be created in RAM to
manage OSS permissions.
Policy

Description

AliyunOSSReadOnlyAccess

Grants a RAM user read-only permission
for OSS instances.

AliyunOSSFullAccess

Grants a RAM user full management
permissions for OSS instances.

Note:

For more information about OSS permissions, see Overview.

Attach custom policies to RAM users

1. Create custom policies according to the subsequent OSS authorization examples.
For more information, see Create a custom policy.

2. Locate the target policy and click the policy name.
3. On the References tab, click Grant Permission.

4. In the Principal ﬁeld, enter the ID or name of the target RAM user.
5. Click OK.

Note:

You can also attach policies to a RAM user or a RAM user group as needed. For

more information, see Grant permission to a RAM userand Grant permission to a
RAM user group.

OSS authorization examples

• Example 1: As a RAM administrator, authorize a user to fully manage an OSS
bucket.
{

" Version ": " 1 ",
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" Statement ": [
{
" Effect ": " Allow ",
" Action ": " oss :*",
" Resource ": [
" acs : oss :*:*: myphotos ",
" acs : oss :*:*: myphotos /*"
]
}
]

}

• Example 2: As a RAM administrator, authorize a user to list and read resources in
an OSS bucket.

- Authorize a RAM to list and read resources in an OSS bucket by using the OSS
CLI or by using OSS SDKs. The name of the OSS bucket is myphotos .
{

}

" Version ": " 1 ",
" Statement ": [
{
" Effect ": "
" Action ": "
" Resource ":
},
{
" Effect ": "
" Action ": "
" Resource ":
}
]

Allow ",
oss : ListObject s ",
" acs : oss :*:*: myphotos "
Allow ",
oss : GetObject ",
" acs : oss :*:*: myphotos /*"

- Authorize a RAM user to operate on resources in the OSS console.
Note:

When a RAM user logs on to the OSS console, the console calls the
ListBucket

s , GetBucketA

whether the bucket is public.
{
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" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : ListBucket s ",
" oss : GetBucketS tat ",
" oss : GetBucketI nfo ",
" oss : GetBucketA cl "
],
" Resource ": " acs : oss :*:*:*"
},
{
" Effect ": " Allow ",
" Action ": [

cl actions to check
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" oss : ListObject
" oss : GetBucketA

},
{

]

}

}

s ",
cl "

],
" Resource ": " acs : oss :*:*: myphotos "
" Effect ": " Allow ",
" Action ": [
" oss : GetObject ",
" oss : GetObjectA cl "
],
" Resource ": " acs : oss :*:*: myphotos /*"

• Example 3: As a RAM administrator, authorize a RAM user to access OSS instances
by using a speciﬁed IP address.

- Add the following condition in the Allow element. This allows the IP address
segments 192 . 168 . 0 . 0 / 16 and 172 . 12 . 0 . 0 / 16 to read
data in myphotos .
{

" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : ListBucket s ",
" oss : GetBucketS tat ",
" oss : GetBucketI nfo ",
" oss : GetBucketA cl "
],
" Resource ": [
" acs : oss :*:*:*"
]
},
{
" Effect ": " Allow ",
" Action ": [
" oss : ListObject s ",
" oss : GetObject "
],
" Resource ": [
" acs : oss :*:*: myphotos ",
" acs : oss :*:*: myphotos /*"
],
" Condition ":{
" IpAddress ": {
" acs : SourceIp ": [" 192 . 168 . 0 . 0 / 16
", " 172 . 12 . 0 . 0 / 16 "]
}
}
}
]
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}

- Add the following condition in the Deny element. If the IP address of a RAM
user is not within the 192 . 168 . 0 . 0 / 16 segment, the user cannot
perform any operations on OSS instances.
{

"]

}

" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : ListBucket s ",
" oss : GetBucketS tat ",
" oss : GetBucketI nfo ",
" oss : GetBucketA cl "
],
" Resource ": [
" acs : oss :*:*:*"
]
},
{
" Effect ": " Allow ",
" Action ": [
" oss : ListObject s ",
" oss : GetObject "
],
" Resource ": [
" acs : oss :*:*: myphotos ",
" acs : oss :*:*: myphotos /*"
]
},
{
" Effect ": " Deny ",
" Action ": " oss :*",
" Resource ": [
" acs : oss :*:*:*"
],
" Condition ":{
" NotIpAddre ss ": {
" acs : SourceIp ": [" 192 . 168 . 0 . 0 / 16

]

}

}

}

Note:

A policy with the Deny command has a higher priority than the policy with the
Allow command. Therefore, when a RAM user whose IP address is not within

the 192 . 168 . 0 . 0 / 16 segment attempts to access data in myphotos
, OSS notiﬁes the user of having no permissions.
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• Example 4: Authorize a RAM user by OSS directory.

You have a photo bucket named myphotos. The bucket contains directories that
indicate the places where the photos were taken. Each directory contains subdirectories that indicate the years when the photos were taken.
myphotos [ Bucket ]
├── beijing
│
├── 2014
│
└── 2015
├── hangzhou
│
├── 2013
│
├── 2014
│
└── 2015 // Grant
directory
to
users .
└── qingdao
├── 2014
└── 2015

read - only

permission

on

this

You can grant read-only permission on the myphotos / hangzhou / 2015 /

directory to a RAM user according to application scenarios and policy complexity.
The following are examples of the application scenarios:

- Scenario 1: Authorize a RAM user to read ﬁles in the directory without them
having to list the ﬁles.

In this scenario, the RAM user knows the complete paths of all ﬁles and can

directly read the ﬁles by using the complete paths. Generally, a software system
requires permission assignment for this.
{
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" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : GetObject "
],
" Resource ": [
" acs : oss :*:*: myphotos / hangzhou / 2015 /*"
]
}
]

39

Resource Access Management

}

Best Practices / 10 Manage OSS permissions by using
RAM

- Scenario 2: Authorize a RAM user to access the myphotos / hangzhou / 2015
/ directory and list ﬁles in the directory by using the OSS CLI.

Generally, software developers require such permission assignment. The

developers do not know what ﬁles are available in a directory and can use the
OSS CLI or API to directly obtain the directory information.
In this scenario, the ListObject
{

40

s permission is required.

" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : GetObject "
],
" Resource ": [
" acs : oss :*:*: myphotos / hangzhou / 2015 /*"
]
},
{
" Effect ": " Allow ",
" Action ": [
" oss : ListObject s "
],
" Resource ": [
" acs : oss :*:*: myphotos "
],
" Condition ":{
" StringLike ":{
" oss : Prefix ":" hangzhou / 2015 /*"
}
}
}
]
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- Scenario 3: Authorize a RAM user to access the myphotos / hangzhou / 2015
/ directory by using the OSS console.

In this scenario, the RAM user uses a visual OSS client, such as Windows File
Explorer, to access the myphotos / hangzhou / 2015 / directory from the
root directory through levels of sub-directories.
The following permissions are required:
■ Permission to list all buckets

■ Permission to list directories under myphotos

■ Permission to list directories under myphotos / hangzhou
{
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" Version ": " 1 ",
" Statement ": [
{
" Effect ": " Allow ",
" Action ": [
" oss : ListBucket s ",
" oss : GetBucketS tat ",
" oss : GetBucketI nfo ",
" oss : GetBucketA cl "
],
" Resource ": [
" acs : oss :*:*:*"
]
},
{
" Effect ": " Allow ",
" Action ": [
" oss : GetObject ",
" oss : GetObjectA cl "
],
" Resource ": [
" acs : oss :*:*: myphotos / hangzhou / 2015 /*"
]
},
{
" Effect ": " Allow ",
" Action ": [
" oss : ListObject s "
],
" Resource ": [
" acs : oss :*:*: myphotos "
],
" Condition ": {
" StringLike ": {
" oss : Delimiter ": "/",
" oss : Prefix ": [
"",
" hangzhou /",
" hangzhou / 2015 /*"
]
}
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]

}
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11 Manage RDS permissions by using RAM

This topic describes how to manage RDS permissions of RAM users by creating
policies in RAM.

Common policies

The following table lists some common policies that can be created in RAM to
manage RDS permissions.
Policy

Description

AliyunRDSReadOnlyAccess

Grants a RAM user read-only permission
for RDS instances.

AliyunRDSFullAccess

Grants a RAM user full management
permissions for RDS instances.

Note:

For more information about RDS permissions, see RAM authorization.

Attach custom policies to RAM users

1. Create custom policies according to the subsequent RDS authorization examples.
For more information, see #unique_50.

2. Locate the target policy and click the policy name.
3. On the References tab, click Grant Permission.

4. In the Principal ﬁeld, enter the ID or name of the target RAM user.
5. Click OK.

Note:

You can also attach policies to a RAM user or a RAM user group as needed. For
more information, see Permission granting in RAM.

RDS authorization examples

• Example 1: As a RAM administrator with multiple instances, authorize a user to
operate on only two of your instances.

The IDs of these two RDS instances are i-001 and i-002.
{
Issue: 20190815
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" Statement ": [
{
" Action ": " rds :*",
" Effect ": " Allow ",
" Resource ": [
" acs : rds :*:*: dbinstance / i - 001 ",
" acs : rds :*:*: dbinstance / i - 002 "
]
},
{
" Action ": " rds : Describe *",
" Effect ": " Allow ",
" Resource ": "*"
}
],
" Version ": " 1 "

Note:

- The authorized RAM user can view all the RDS instances but can only operate
on two of them.

- The Describe * element is required in a policy. If a policy does not contain

the Describe * element, the authorized RAM user cannot view any instance
in the console. However, the RAM user can operate on the two speciﬁed RDS
instances by calling API actions, by using the CLI, or by using RDS SDKs.

• Example 2: As a RAM administrator, authorize a user to access data in the Alibaba
Cloud Data Management System (DMS).

- Authorize a RAM user to access a speciﬁed RDS instance.
{

}

" Statement ": [
{
" Action ": " dms : LoginDatab ase ",
" Effect ": " Allow ",
" Resource ": " acs : rds :*:*: dbinstance / rds783a063
9ks5k7 ****"
}
],
" Version ": " 1 "

Note:

You need to replace rds783a063
instance to be accessed.

9ks5k7 **** with the ID of the RDS

- Authorize a RAM user to access all RDS instances.
{
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" Action ": " dms : LoginDatab ase ",
" Effect ": " Allow ",
" Resource ": " acs : rds :*:*:*"

}
],
" Version ": " 1 "

Issue: 20190815
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12 Manage SLB permissions by using RAM

This topic describes how to manage SLB permissions of RAM users by creating
policies in RAM.

Common policies

The following table lists some common policies that can be created in RAM to
manage SLB permissions.
Policy

Description

AliyunSLBReadOnlyAccess

Grants a RAM user read-only permission
for SLB instances.

AliyunSLBFullAccess

Grants a RAM user full management
permissions for SLB instances.

Note:

For more information about SLB permissions, see RAM authentication.

Attach custom policies to RAM users

1. Create custom policies according to the subsequent SLB authorization examples.
For more information, see #unique_50.

2. Locate the target policy and click the policy name.
3. On the References tab, click Grant Permission.

4. In the Principal ﬁeld, enter the ID or name of the target RAM user.
5. Click OK.

Note:

You can also attach policies to a RAM user or a RAM user group as needed. For
more information, see Permission granting in RAM.

SLB authorization examples

• Example 1: As a RAM administrator with multiple instances, authorize a user to
operate on only two of your instances.

The IDs of these two SLB instances are i-001 and i-002.
{
46
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" Statement ": [
{
" Effect ": " Allow ",
" Action ": " slb :*",
" Resource ": [
" acs : slb :*:*: loadbalanc
" acs : slb :*:*: loadbalanc
]
},
{
" Effect ": " Allow ",
" Action ": " slb : Describe *",
" Resource ": "*"
}
],
" Version ": " 1 "

er / i - 001 ",
er / i - 002 "

Note:

- The authorized RAM user can view all the SLB instances but can only operate
on two of them.

- The Describe * element is required in a policy. If a policy does not contain

the Describe * element, the authorized RAM user cannot view any instance
in the console. However, the RAM user can operate on the two speciﬁed SLB
instances by calling API actions, by using the CLI, or by using SLB SDKs.

• Example 2: As a RAM administrator, authorize a user to add ECS instances to an
SLB instance. The ID the SLB instance is i-001.
{

}

" Statement ": [
{
" Effect ": " Allow ",
" Action ": " slb : AddBackend Servers ",
" Resource ": [" acs : slb :*:*: loadbalanc er / slb - 001 "]
},
{
" Effect ": " Allow ",
" Action ": " slb : AddBackend Servers ",
" Resource ": [" acs : ecs :*:*: instance / i - 001 "]
},
{
" Effect ": " Allow ",
" Action ": " slb : DescribeLo adBalancer s ",
" Resource ": " acs : slb :*:*: loadbalanc er /*"
}
],
" Version ": " 1 "

Note:
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After you have granted the SLB management permission to a RAM user according
to the policy described in example 1, you also need to grant the following

permissions to the user so that the user can add or remove ECS instances, or set
the weight of ECS instances as needed:
- The permission for SLB resources

- The permission for ECS resources

• Example 3: As a RAM administrator, authorize a user to perform any ECS-related
operations on a speciﬁed SLB instance.
{

}

" Statement ": [
{
" Effect ": " Allow ",
" Action ": " slb :*",
" Resource ": [
" acs : slb :*:*: loadbalanc
" acs : slb :*:*: loadbalanc
]
},
{
" Effect ": " Allow ",
" Action ": " slb : Describe *",
" Resource ": "*"
},
{
" Effect ": " Allow ",
" Action ": " slb :*",
" Resource ": " acs : ecs :*:*:*"
}
],
" Version ": " 1 "

er / i - 001 ",
er / i - 002 "

Note:

The preceding policy allows a RAM user to manage two speciﬁed SLB instances
(IDs: i-001 and i-002) and perform all ECS-related operations on these two SLB

instances, for example, add ECS instances to these two SLB instances and set the
weight of ECS.
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13 Manage CDN permissions by using RAM

This topic describes how to manage CDN permissions of RAM users by creating
policies in RAM.

Common policies

The following table lists some common policies that can be created in RAM to
manage CDN permissions.
Policy

Description

AliyunCDNReadOnlyAccess

Grants a RAM user read-only permission
for CDN instances.

AliyunCDNFullAccess

Grants a RAM user full management
permissions for CDN instances.

Note:

For more information about CDN permissions, see API authentication rules.

Authorize a RAM user to perform the read-only, cache refresh, and push operations on CDN
instances

1. Create a custom policy.
{

}

" Version ": " 1 ",
" Statement ": [
{
" Action ": [
" cdn : Describe *",
" cdn : PushObject Cache ",
" cdn : RefreshObj ectCaches "
],
" Resource ": " acs : cdn :*:*:*",
" Effect ": " Allow "
}
]

For more information, see #unique_50.

2. Locate the target policy and click the policy name.
3. On the References tab, click Grant Permission.

4. In the Principal ﬁeld, enter the ID or name of the target RAM user.
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Note:

You can also attach policies to a RAM user or a RAM user group as needed. For
more information, see Permission granting in RAM.
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14 Record RAM operations by using ActionTrail

This topic describes how to record operations of an Alibaba Cloud account or a RAM
user on resources by using ActionTrail.

View RAM operations by using ActionTrail

1. Log on to the ActionTrail console.

2. On the History Search page, use the Filter drop-down list to search for the target
event.

3. Click the event, then click View event.

Operations recorded by ActionTrail

ActionTrail can record the following RAM operations:

• Logon information of an Alibaba Cloud account or a RAM user. For more
information, see ConsoleSignin event log examples.

• Operations in the RAM console. The following is an example of a recorded
operation event:
{

",

}

"
"
"
"
"
"
"
"

apiVersion ":" 2015 - 05 - 01 ",
eventId ":" 2cc52dee - d8d2 - 40c2 - 8de0 - 3a2cf1df ****",
eventName ":" DeleteGrou p ",
eventSourc e ":" ram . aliyuncs . com ",
eventTime ":" 2015 - 11 - 03T13 : 41 : 49Z ",
eventType ":" ApiCall ",
eventVersi on ":" 1 ",
requestId ":" 9AE24F49 - C52C - 4F0F - BCF9 - 9A4B8C22B1 47

" requestPar ameters ":{
" GroupName ":" grp1 ",
},
" serviceNam e ":" Ram ",
" sourceIpAd dress ":" 42 . 120 . XX . XX ",
" userAgent ":" AliyunCons ole ",
" userIdenti ty ":{
" type ":" ram - user ",
" principalI d ":" 2741806465 4829 ****",
" accountId ":" 1234567890 12 ****",
" userName ":" Alice ",
" sessionCon text ":{
" sessionAtt ributes ":{
" creationDa te ":" 2015 - 11 - 03T13 : 41 : 48Z ",
" mfaAuthent icated ":" true "
}
}
}
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• RAM and STS API calls for resource creation, change, and deletion. The following
is an example of a recorded event:
{

",

}

"
"
"
"
"
"
"
"
"

apiVersion ": " 2015 - 05 - 01 ",
eventId ": " 234ef3c7 - 8938 - 4bd7 - bb80 - 11754b7b ****",
eventName ": " CreateGrou p ",
eventSourc e ": " ram . aliyuncs . com ",
eventTime ": " 2016 - 01 - 04T08 : 58 : 50Z ",
eventType ": " ApiCall ",
eventVersi on ": " 1 ",
recipientA ccountId ": " 43274 ",
requestId ": " 1485748C - DB62 - 4693 - AB7E - 4BA3F3A970 E1

" requestPar ameters ": {
" Comments ": " this
is
a
test
group ",
" GroupName ": " grp1 "
},
" serviceNam e ": " Ram ",
" sourceIpAd dress ": " 42 . 120 . XX . XX ",
" userAgent ": " aliyuncli / 2 . 0 . 6 ",
" userIdenti ty ": {
" type ": " ram - user ",
" principalI d ": " 2741806465 4829 ****",
" accountId ": " 43274 ",
" accessKeyI d ": " f6Iz ******** EI4d ",
" userName ": " Alice "
}

What to do next

For more information about operation records, see ActionTrail event log syntax.
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resources

This topic describes how to authorize RAM users to use ActionTrail resources by
using system policies or custom policies.

Before you begin

1. View the ActionTrail API actions and their descriptions. For more information, see
RAM account authentication.

2. View the RAM policy structure and syntax. For more information, see Policy
structure and grammar.

Procedure

1. Create a RAM user.

For more information, see #unique_66.

2. Grant permission to the RAM user.

• You can grant required permissions to the RAM user by attaching one or more

system policies according to the subsequent ActionTrail-related system policies.
For more information, see Permission granting in RAM.

• You can grant ﬁne-grained permissions to the RAM user by creating custom
policies according to the subsequent authorization examples.
For more information, see #unique_50.

ActionTrail-related system policies

The following table lists the system policies that are commonly used in ActionTrail.
Table 15-1: System policies
System policy

Description

AliyunActionTrailReadOnlyAccess

Grants a RAM user read-only permission
for ActionTrail resources.

AliyunActionTrailFullAccess
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Grants a RAM user full management
permissions for ActionTrail resources.

53

Resource Access Management

Best Practices / 15 Authorize RAM users to use
ActionTrail resources

Authorization examples

• Example 1: As a RAM administrator, grant a user read-only permission.
{

}

" Version ": " 1 ",
" Statement ": [{
" Effect ": " Allow
" Action ": [
" actiontrai l
" actiontrai l
" actiontrai l
],
" Resource ": "*"
}]

",
: LookupEven ts ",
: Describe *",
: Get *"

• Example 2: As a RAM administrator, grant a user read-only permission when they
log on from a speciﬁed IP address.
{

}
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" Version ": " 1 ",
" Statement ": [{
" Effect ": " Allow ",
" Action ": [
" actiontrai l : LookupEven ts ",
" actiontrai l : Describe *",
" actiontrai l : Get *"
],
" Resource ": "*",
" Condition ":{
" IpAddress ": {
" acs : SourceIp ": " 42 . 120 . XX . X / 24 "
}
}
}]
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